
C hap te r 1

The Revit Architecture 
User Interface

In this chapter,  we’ll explore the Revit Architecture user interface (UI). 

If you have never used Revit Architecture before, then you will quickly notice that this 

doesn’t even come close to resembling AutoCAD or MicroStation. There is no command 

prompt, there are no crosshairs, and the background is white, not black (though you 

can adjust that). Revit Architecture is similar to other Windows-based applications that 

utilize the Microsoft Office ribbon interface. Users familiar with the ribbon should find 

learning Revit Architecture’s UI relatively straightforward after they have learned the 

underlying concepts.

In this chapter, we’ll cover the following:

The recent files screen■■

The main screen■■
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2  ■   Chapter 1 : The Revit Architecture User Interface

The Home Screen
After you start Revit, you are taken to the Recent Files screen (see Figure 1.1). This win-

dow provides you with quick access to a list of the most recently opened projects or fami-

lies. The main area of the screen is divided into three areas. The top section, Projects, 

provides options for opening and creating new projects as well as icons to the right listing 

any recent projects that you have been working on. The middle section, Families, pro-

vides options for opening and creating new families as well as icons to the right listing 

any recent families that you have been working on. The bottom section, Resources, pro-

vides access to additional resources on learning Revit.

If you have started Revit for the first time, then you will only be given the option to open or 

create new projects or families. The recent files icons will display two sample projects and 

two sample families.

So you can further explore the user interface, we will show how to create a new proj-

ect; Revit provides two methods to accomplish this. The first is to click the New button 

in the Projects area. When you do this, Revit will create a new project using the default 

settings found in the default template called default.rte. This method allows you to start 

working immediately but is normally not the best method. Later in the chapter we will 

discuss how to create a new project using a user-selected template.
Figure 1.1

Recent Files screen
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The Main Screen
Now that you have started a project using the template file by clicking New, the window 

shown in Figure 1.2, which is the main screen, appears. The user interface is divided into 

several areas; we will discuss each of them in the following sections.

Application menu Quick Access toolbar Tab bar InfoCenter toolbar

Properties palette

Options bar

Ribbon

Window controls

Drawing area

Navigation bar

Project Browser

View Control bar Workset controls Design option controls Filter controls

Menu and Toolbar
Located at the top left of the screen (see Figure 1.3), the application menu gives you access 

to most of your file management tasks such as New, Open, Save, and so on, as well as 

access to exporting tools, printing, recent documents, and the Options dialog box, which 

allows you to tailor some custom settings in Revit that we will discuss later in the book. 

The right side of the application menu contains a list of recently opened files. You can use 

the pushpin icon located to the right of the filename to “pin” that file to the list, making it 

easier to find it each time you start Revit. In addition to providing quick access to project 

operations in one place, the application menu also allows you to sort and access recent 

documents.

Figure 1.2

Main screen
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4  ■   Chapter 1 : The Revit Architecture User Interface

The Quick Access toolbar (QAT) is filled 

with some of the most popular commands and 

is user customizable (Figure 1.4). There are 

two ways to customize the QAT. To add a tool 

to the QAT, right-click the tool on the ribbon, 

and then choose Add To Quick Access Toolbar. 

The second method is to use the Add/Remove 

buttons (Figure 1.5) at the end of the QAT to 

add, remove, and rearrange the buttons on 

the QAT. You can also right-click the QAT to 

remove icons, add a QAT separator line, and 

customize the QAT.

1. Click the Add/Remove button.

2. Choose Customize Quick Access Toolbar.

3. Use the move, 
separator, and 
delete buttons.

The QAT can appear above or below the ribbon. To change the location, follow  

these steps:

	 1.	 Click the Customize Quick Access Toolbar drop-down.

	 2.	 Scroll to the bottom of the dialog box, and select either Show Below The Ribbon  

or Show Above The Ribbon.

Figure 1.3

Application menu

Figure 1.4

Quick Access toolbar

Figure 1.5

Customizing 
 the QAT
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The Main Screen  ■   5

To the right of the QAT is the InfoCenter toolbar (Figure 1.6). You use the InfoCenter 

to search for information using keywords or phrases, to access subscription services, and to 

search for topics in the help files. 

When you want to choose a template for creating your project, use the following steps 

after you’ve started Revit:

	 1.	 Click the application menu, and select New ➔ 

Project.

This opens the New Project dialog box (Figure 1.7). Here, you have the ability to 

choose which template you want to utilize to start your project. You can also start 

your project without using a template file or create a new template file.

	 2.	 In the New Project dialog box, click Browse 

under Template File.

	 3.	 Navigate to your local project template loca-

tion, select the template file (.rts file exten-

sion), and click Open.

	 4.	 For Create New, make sure that the Project 

radio button is selected.

	 5.	 Click OK.

Ribbon
Below the application menu and QAT is the ribbon (Figure 1.8). The ribbon is the most 

common method for initiating commands in Revit to help you define your building 

project. The Revit user interface is based on Microsoft Office 2007’s ribbon interface. The 

interface is a set of dynamic or contextual toolbars that are placed in tabs in a tab bar. 

What we mean by that is if you are placing a wall, a new Modify | Place Wall tab is dis-

played with specific functionality for placing or modifying walls. These new contextual 

tabs are visible only when that tool is active.

The ribbon is broken up into two main parts. The top is the tab bar. Nine main tabs 

hold all of the tools. Clicking a tab makes it active. Table 1.1 provides an overview of the 

tools in each tab.

Figure 1.6

InfoCenter

Figure 1.7

New Project  
dialog box

Figure 1.8

The ribbon
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6  ■   Chapter 1 : The Revit Architecture User Interface

T a b  N a m e T o o l s

Home The tools provided are commonly used tools for creating and placing building  
elements.

Insert The tools provided are for linking, importing, and loading families, as well as for  
searching for family content online.

Annotate The tools provided are for dimensions, detailing, adding text, tagging, keynoting,  
and adding symbols.

Structure The tools provided are for adding structural members, foundations, and datum  
elements.

Massing & Site The tools provided are for creating conceptual masses and creating and editing  
site elements.

Collaborate The tools provided are for collaborating with both internal and external team  
members.

View The tools provided are for controlling graphic settings of objects, creating views,  
adding sheets, and managing views.

Manage The tools provided are for managing the project settings and environment, which 
include project settings, the project location, design options, phasing, and macros.

Modify | Tag This a contextual tab that will change based upon the operation being performed.  
The tools provided are for modifying and tagging elements.

The second part of the ribbon is a set of toolbars, one for each tab. The toolbars are 

divided into panels with each panel holding tools or options pertaining to a specific 

activity or function. If you find yourself using a particular panel over and over again, 

it can be “torn off” the ribbon and placed where you want it on the screen (Figure 1.9). 

When you do this, you are making a floating toolbar on your screen. So if you are using 

multiple monitors, you can place some of your favorite and most often used ones on one 

screen, while your model is on another. When you do this, Revit will remember the user-

defined locations of the panels the next time you open Revit. You can move a panel by 

clicking and dragging the panel label to the new location either within the toolbar or into 

the drawing area or other location on your desktop.

If you have “torn off” a panel and want to restore it, move your 

mouse cursor over the panel you want to restore. Gray bars will 

appear on both sides of the floating panel (Figure 1.10). The gray 

bar on the left side allows you to relocate the panel when you drag to the new location. 

On the right side of the gray bar, you will see a small icon; when you click that icon, the 

panel will be restored to the original location.

Table 1.1

Ribbon Tabs 

Figure 1.9

Panels can be “torn 
off” the ribbon and 

repositioned.

Figure 1.10

Panels positioning 
controls

Click icon to reset panel 
to original location

Drag to move panel
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The Main Screen  ■   7

You can customize the ribbon further by changing the view state to one of the three 

settings. You can adjust the view state by clicking the arrow control to the far right of the 

tab bar to cycle through the options (Figure 1.11), as described here:

Show the full ribbon. This is the default state and shows the tab labels, panel labels, •	

and tool icons. 

Show the tab and panel labels. When you move your cursor over the panel label, the •	

tools for those panels will be displayed.

Show tab labels. When you move your cursor over the tab label, the tools for those •	

panels will be displayed.

Show full ribbon

View State 
Control button

Shows tab and panel labels

Show tab labels

Ribbon Controls

The final elements of the ribbon are the tool controls, of which there are three types:

Buttons that initiate a command, function, or option.•	

Expanded panel arrow allows you to expand the panel to display additional related •	

tools and controls.

Dialog launcher buttons that allow you to open another dialog box to define  •	

additional options or settings to complete a task. The dialog launcher buttons  

are the small icons to the far right of a panel on the same line as the panel name  

(Figure 1.12).

Buttons come in three different types: button, drop-

down, and split buttons. If you look on the Home tab, 

you can see the Door and Window tools on that Build 

panel; they are examples of buttons. When you click 

this type of button, the tool is invoked, and you are provided with options to place a door 

or window. In the Model panel, the Model Group tool is an example of a drop-down 

Figure 1.11

The three different 
ribbon view states

Figure 1.12

Dialog  
launcher icon
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8  ■   Chapter 1 : The Revit Architecture User Interface

button (Figure 1.13). When you click that type of button, a list appears showing the dif-

ferent options for the tool. You can then pick the different tool options.

The split button serves two functions; when you move 

your cursor over a split button, you will see either a hori-

zontal or vertical divider line on the icon. The Wall and 

Column buttons are examples of split buttons. The por-

tion of the button that contains the small block triangle 

(Figure 1.14) functions like a drop-down button. The 

other half of the button functions like a regular button.

Some ribbon panels have a drop-down arrow next to the panel 

title (Figure 1.15) that indicates that the panel can be expanded to 

display additional related tools and controls (Figure 1.16). These 

are known as expanded panels. 

Ribbon Clues

You might have noticed that some buttons in different 

toolbars are grayed out (Figure 1.17). If a particu-

lar tool is not available, then it will be grayed out 

because the tool will not function. An example of this 

is the Level tool in the Datum panel of the Home tab 

if you are in a plan view. Revit does not permit you 

to create a new level in a plan view, so the Level tool 

is grayed out. Titleblocks can be added in plan views, 

rendering needs to be done in a 3D view, and walls can’t be drawn 

in an elevation views—these are just some of the examples of the 

restrictions. If a tool is grayed out, switch to a different view type.

Another feature of the ribbon are tooltips 

(Figure 1.18). Tooltips provide a brief descrip-

tion of the tool’s function. When you move 

your cursor over a tool on the ribbon, by 

default Revit will display a tooltip. If you leave 

your cursor over the tool a little longer, addi-

tional information in the form of an expanded 

tooltip will be displayed. While the tooltip is 

visible, you can press F1 for context-sensitive 

help to provide additional information about 

the tool. (Elements that are traditionally called 

tooltips are typically a word or phrase, but 

as you can see in Figure 1.18, some of Revit’s 

tooltips are much larger, even a whole panel 

and illustration.)

Figure 1.13

Example of a  
drop-down button

Figure 1.14

Example of a  
split button

Figure 1.15

Dimension panel 
with expanded 

panel arrow

Figure 1.16

Dimension 
expanded panel

Figure 1.17

Examples of two 
grayed-out buttons

Figure 1.18

Expanded  
tooltip for the  

Trim/Extend tool
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Options Bar
The Options bar (Figure 1.19) is located just under the ribbon and displays options that 

are specific to the active tool or selected elements. For example, if you are placing a wall, 

you are presented with options that include the height, location line, chain, offset, and 

radius. When you place a window, you are presented with options for window tag orien-

tation, tag type, leader usage, and leader offset.

The Options bar is also active when you select an existing element to edit. If you select 

a window and want to copy that multiple times, simply select the window, click the Copy 

button on the Modify tab, and then select the Multiple 

check box on the Options bar (Figure 1.20).

It is very important to pay attention to the Options bar as you work, no matter your 

experience level. The Options bar will provide you with options to help you create ele-

ments in your project.

Properties Palette
The Properties palette (Figure 1.21) is where you can 

view and modify the various parameters that define 

the properties of elements in Revit. By default the 

Properties palette is located under the Options bar and 

to the far left; it is broken up into two main areas.

The top portion is the Type Selector and lists all of 

the various types available for given elements that are 

currently loaded into the project file. In Revit, families 

are components you use to build your model, such as 

walls, windows, doors, columns, and so on. A door 

family can have multiple variations or, in Revit terms, 

types. Types are different sizes, materials, and so on. 

For example, a Single-Flush window might have sev-

eral different standard-size configurations. If you make a change to a type that is already 

used in the project, then it is updated in every instance throughout the project. If you 

have a window type called 24×80 and you change the size to 30˝×75 ,̋ then all the 24×80 

windows will be updated so that they are now 30˝×75 ,̋ regardless of their name.

Figure 1.19

Options bar  
examples for  
different tools

Figure 1.20

Options bar  
example with  
the Multiple  
copy option

Figure 1.21

Properties palette

Instance properties

Type Selector
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10  ■   Chapter 1 : The Revit Architecture User Interface

U n i t s

This book references both imperial and metric units (imperial first, followed by metric equiv-

alent in parentheses). We make an exception for instances like this, where we’re talking only 

about the element in general rather than the actual dimensions of something.

When you create new elements, you use the Type Selector to select the family and type 

that you want to insert into your project. If you select an element that is already in the 

model, you can use the Type Selector to change it to a different type.

Families are broken up into different element categories. Some examples of categories 

are doors, walls, windows, floors, and so on. When you use the Door tool to place a door, 

only door categories will be shown in the Type Selector. So, the Type Selector is only 

going to display the appropriate category, families, and types for the one in use. We will 

discuss more about families in later chapters.

The bottom portion of the Properties palette contains the instance properties. Instance 

properties control only the instances (in other words, the elements) you have selected. 

Instance properties are sometimes referred to as element 

properties. For example, when you change the door’s fin-

ish material, then only the door you selected will have 

that finish description. When you change the door mark, 

then only that particular door is changed.

If you have selected multiple elements, the Type 

Selector will display the common type if possible. For 

example, if you selected five windows but they are not 

the same type (Single-Flush and Double-Flush) or if you 

have elements of different categories such as a door and 

window, Revit will display a message in the Type Selector: 

“Multiple Categories selected.” The instance properties 

will display only those properties that are common to the 

selected elements (Figure 1.22).

While we are on the subject of properties, we should 

also discuss type properties. You can access them from the 

Properties palette by clicking the Edit Type button under 

and to the right of the Type Selector (Figure 1.23). Type 

properties control every instance (or all elements) of a 

specific type in the project, regardless of whether they are 

selected. Like instance properties, if multiple elements 

are selected, the Type Properties dialog box includes only 

those properties that all the selected elements have in com-

mon. Figure 1.24 shows an example of the type properties 

for a door.

Figure 1.22

Properties palette 
with door and  

window selected

Figure 1.23

Click the Edit Type 
button on the Prop-

erties palette to 
access the element’s 

type properties.

Click to open the select 
element(s) type properties.
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The Properties palette displays properties that are both user-editable and read-only. 

To edit a user-editable property value, click in the field to the right of the property name, 

and either enter a new value, select one from a drop-down list, or select/deselect a check 

box. For some properties, the value box contains a button to the far right that opens a 

dialog box or browser window in which you define the desired value.

Project Browser
As you work with Revit, you are going to find you are working on 

a fully integrated model. This means that all your views, details, 

sheets, schedules, and so on, are generally in a single workspace. 

Other applications, such as AutoCAD Architecture or Bentley 

Architecture, use a federated model approach where you might 

have tens if not hundreds of drawing files in multiple folders for a 

project. Rather than using Windows Explorer or some other tool 

to manage files, in Revit you can use the Project Browser to man-

age and navigate your projects.

You can find the Project Browser under the Properties palette 

(Figure 1.25). The Project Browser is organized by category in 

a Windows Explorer–like tree. All the different view categories 

such as floor plans, ceiling plans, 3D views, legends, schedules, 

details, sections, elevations, sheets, families, groups, and Revit 

links are displayed. These views in the Project Browser can be 

Figure 1.24

Type properties 
for a Single-Flush 
34˝×84˝ door

Figure 1.25

Project Browser
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12  ■   Chapter 1 : The Revit Architecture User Interface

sorted, grouped, and filtered to help you organize your project. The Project Browser, like 

other dialog boxes in Revit, can be docked, or you can drag it to a new location such as a 

second monitor.

Using the Project Browser is very straightforward. We will cover a few of the basics 

here and get into more detail throughout the text. When you double-click a view name, 

that view is opened in the drawing area. When a view is active, the view name in the 

Project Browser is now bold.

Drawing Area
The drawing area is the large workspace under the Options bar; it’s to the right of the 

Project Browser and Properties palette. The drawing area displays the current view that 

you are working on, and a new window will open for each view. If you have multiple views 

open and the views are maximized, then the other views will be under the current view. 

View Control Bar

The View Control bar (Figure 1.26) is located in the lower-left corner of each drawing 

area window. The View Control bar serves a couple of different purposes to control the 

graphical view for each window. Working from left 

to right are the following functions for the View 

Control bar.

Scale  ​This allows you to change the scale of a view. 

When you click the scale text, a pop-up menu will 

display allowing you to change the scale of your view 

(Figure 1.27). One of the great things about Revit 

is that when you change the scale of a view, annotations and symbols will automatically 

adjust. You don’t have to worry about the scale factor or making adjustments to text sizes 

or dimension scales.

Detail Level  ​This allows you to select from three different detail levels: 

Coarse, Medium, and Fine. If you want to see more graphical information, 

then you would set your detail level from Coarse to Fine.

Visual Style  ​This allows you to you to specify visual style options, which are 

one of the following:

Wireframe  ​Displays the image of the model with all the edges and lines 

drawn but without surfaces

Hidden Line  ​Displays the image of the model with all edges and lines 

drawn except those obstructed by surfaces

Shaded  ​Displays the image of the model with all surfaces shaded 

according to their material color settings and project light locations

Figure 1.26

View Control bar

Scale
Detail Level

Visual Style

Sun Path
On/Off

Shadows On/Off

Crop Region On/Off

Show/Hide Crop Region

Temporary Hide/Isolate

Reveal Hidden Elements

Figure 1.27

Scale listings from 
View Control bar
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Shading With Edges  ​Displays the image of the model in shaded mode, but with all 

nonblocked edges drawn as well

Consistent Colors  ​Displays an image of the model similar to Shading With Edges 

with more consistent colors

Realistic  ​Displays the image of the model with materials in the active view 

Sun Path On/Off  ​This allows you to specify Sun Settings and to turn on or off Sun Path. 

Shadows On/Off  ​ This allows you to specify to turn on or off shadows. There are addi-

tional graphic display options consisting of Shadows and Silhouette Edges.

Show/Hide Rendering Dialog  ​This allows you to either display or hide the Render Settings 

dialog box.

Crop Region On/Off  ​This allows you to turn on or off a crop region.

Show/Hide Crop Region  ​This allows you to show or hide a crop region.

Temporary Hide/Isolate  ​This allows you to temporarily hide or isolate elements or 

categories.

Reveal Hidden Elements  ​This allows you to reveal hidden elements in the view.

Status Bar

The Status bar (Figure 1.28) is located at the very bottom of the UI. It provides you with 

the following information:

Displays the name and family type of the element your cursor is over•	

Prompts you for additional information regarding the active tool such as hints or •	

what to do next

Status bar information Worksets Design options Filter

In addition to providing feedback and information, the Status bar contains the follow-

ing controls:

Workset  ​Provides access to the Workset dialog box and displays the active workset when 

worksharing has been enabled

Design Options  ​Provides access to the Design Options dialog box and displays the active 

design option

Active Only  ​Allows you to filter your selections to only select active design options 

components

Exclude Options  ​Provides the ability to filter components that are part of a design option

Figure 1.28

Status bar prompt-
ing for additional 
information
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14  ■   Chapter 1 : The Revit Architecture User Interface

Editable Only  ​Allows you to filter your selections to only select editable workshared 

components

Press & Drag  ​Allows you to drag an element without selecting it first

Filter  ​Allows you to refine your selection set using element categories

K e y b oar d Acc e le r ato r s

If you are a seasoned AutoCAD user, then you probably initiated most of your commands 

by pressing a one- or two-key shortcut on the keyboard rather than picking a button or 

selecting a tool from a menu. Revit pro-

vides the same functionality for using and 

editing shortcuts. Many of Revit tools have 

predefined keyboard shortcuts. You can 

find them in several different ways. In the 

example shown here, the first line of the 

Component tooltip lists the name of the tool 

followed by the two-key shortcut.

You can also display and edit keyboard 

shortcuts by accessing the Keyboard Short-

cut dialog box. You can access the dialog by 

clicking the View tab, clicking the Windows 

panel, clicking the User Interface drop-down, 

and selecting Keyboard Shortcuts.
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